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ВВЕДЕНИЕ 

 

Отладочная плата LDM-HELPER-XC7Z015-1CLG485 представляет собой 

master-модуль к мультиплатформенной системе проектирования семейства 

HELPER. Она создана на базе ПЛИС SoC XC7Z015 со встроенным аппаратным 

ядром Dual-core ARM Cortex-A9 фирмы Xilinx в корпусе CLG485. 

Общий вид отладочной платы приведен на рисунке 1. 

 

Рисунок 1. Общий вид отладочной платы LDM-HELPER-XC7Z015-1CLG485 
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1 Основные технические характеристики модуля 

Параметр Значение 
Тип: Отладочная плата 
Архитектура ПЛИС: SoC 
Семейство ПЛИС: XILINX Zynq-7000 
Маркировка ПЛИС: XC7Z015 
Габаритные размеры (ДхШхВ): 130х110х25 мм 
Макетное поле (шаг 2.54 мм): Нет 
Корпус ПЛИС: CLG485 
Количество линий I/O PS IO, GTP, SelectIO 
HR: 128, 4, 150 
Тактовый генератор: 33,33 МГц 
Режим программирования: JTAG 
Напряжение питания платы: +5 В 
Кол-во элементов LEs: 74K Artix-7 FPGA 
Процессор: Dual-core ARM Cortex-A9 
Память: 8Gb x32 DDR3L SDRAM 

Периферия: 
2x UART, 2x CAN 2.0B, 2x I2C, 2x SPI, 4x 32b 
GPIO 

Ethernet: 10\100\1000M (RTL8211E) 
LED индикаторы выходов: 8 
Кнопки входных линий: 5 
Вес: 105 г 

 

Вместе с master-модулем можно использовать slave-модули:  

 Аналоговый модуль – АЦП, ЦАП, Цифровые потенциометры; 

 Радиочастотный модуль - WiFi, ZigBee, Bluetooth; 

 Навигационный модуль - GPS, ГЛОНАСС; 

 Мультимедиа модуль – Аудиокодек, драйвер HDMI; 

 Функциональный модуль – Цифровой термометр, датчик давления, 

FRAM, MRAM, EEPROM, FLASH, IO экспандер, RTC, датчик тока, 

цифровой компас, гироскоп; 

 Силовой модуль – мощные низковольтные, маломощные 

высоковольтные с опторазвязкой ключи; 

 Плата 5-ти осевого ЧПУ модуля (SPI-интерфейс); 

 Плата сбора данных с 5-ти энкодеров (SPI-интерфейс). 

Список модулей постоянно пополняется.  

Возможно изготовление специализированных модулей по ТЗ заказчика. 

 

2 Маркировка и опции 

Отладочная плата поставляется в двух модификациях. 

Маркировка: LDM-HELPER-XC7Z015-1CLG485-FULL (без microUSB разъема X13) 
 
Маркировка: LDM-HELPER-XC7Z015-1CLG485-FULL-F  (c microUSB разъемом X13) 
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3 Описание и работа 

3.1 Принципиальная электрическая схема 
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3.2 Питание и настройка перемычек 

Питание отладочной плата LDM-HELPER-XC7Z015-1CLG485 осуществляется от 

постоянного стабилизированного источника с напряжением +5 В, 0,5÷3 А (выводы 

Vin 22,23 или вывод +5Vusb 64 X2, разъем Х15 или от USB порта X12, 

подключенного кабелем к порту USB персонального компьютера).  

Внимание! Если для питания платы используется USB-порт ПК, убедитесь, что 

минимальный ток не будет ниже 1А. Рекомендуется использовать порт USB 3.0.  

В таблице 1 приведены режимы включения джамперов, переключателей и их 

функции (ver.1.07). 

Таблица 1 

Режимы включения джамперов и их функции 

Джампер Положение Функционал 

SA1 
Нажата Сброс по линии RESET 

Не нажата Рабочий режим 
SA2 SELECT Кнопка джойстика “Выбор” 
SA3 UP Кнопка джойстика “Вверх” 
SA4 DOWN Кнопка джойстика “Вниз” 
SA5 LEFT Кнопка джойстика “Влево” 
SA6 RIGHT Кнопка джойстика “Вправо” 

SA7* 
Нажата Отключение питания от ПЛИС 

Не нажата Питание ПЛИС подключено 

X1 
1-2 VCCBAT = +1,8В 
2-3 VCCBAT = +VBAT 

X2 - Межплатные разъемы модуля 
X3 - Разъем интерфейса JTAG 
X4 - Разъем линий xADC 
X5 - MGTP_Tx/Rx(0) 
X6 - MGTP_Tx/Rx(2) 
X7 - MGTP_Tx/Rx(1) 
X8 - MGTP_Tx/Rx(3) 
X9 - MGTP_CLK(0..1) 

X10 
1-2 MIO[5] = 0 (JTAG) Загрузка через JTAG (X3) 
2-3 MIO[5] = 1 (QSPI Boot) Загрузка из QSPI памяти 

X11 - Разъем интерфейса RS-485 
X12 - Разъем интерфейса USB-UART (UART1) 
X13  Опциональный разъем microUSB интерфейса USB 
X14 - Разъем ETHERNET 10/100/1000 
X15 - Разъем питания +5В 
X16 - Разъем пользовательских I/O с уровнем 1,8В/3,3В/User 

X17 
1-2 +VCC_B35 = +1,8В 
2-3 +VCC_B35 напряжение с вывода X18.2 

X18 
1-2 Выбор напряжения для X17 = +3,3В 
2-3 Выбор напряжения для X17 = напряжению с KT4 

X19 
1-2 +VCC501_ADJ = +3,3В 
2-3 +VCC501_ADJ = +2,5В 

X20 - Разъем пользовательских I/O с уровнем 3,3В 
X21 - Разъем HDMI канала 

 

* - Не допускается периодическое нажатие с интервалом менее 1 сек.  
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3.3 Общая последовательность разработки конфигурации процессора 

Zynq на примере простейшего проекта (UART) 

 

Конфигурирование платформы Zynq можно разделить на две основные части: 

1) Конфигурирование аппаратной части платформы Zynq; 

2) Написание программ для сконфигурированной аппаратной части 

платформы Zynq. 

Рассмотрим более подробно каждый из этапов. 

 

3.3.1 Конфигурирование аппаратной части платформы Zynq 

 

Данный этап выполняется средствами разработки ISE или Vivado IDE. Для 

выбранного нами кристалла XC7Z015-1CLG485 доступно конфигурирование только 

средствами Vivado IDE. Тестовый проект создавался в Vivado 2018.3.  

 

Конфигурирование аппаратной части можно подразделить на следующие под 

этапы: 

1) Создание блок схемы “дизайна” аппаратной части и настройка параметров 

его блоков; 

2) Генерация HDL “обёртки” для созданного “дизайна”; 

3) Добавление файлов физических ограничений в формате XDC. Ucf больше 

не поддерживается; 

4) Синтез и имплементация созданного HDL описания “дизайна”, создание 

файла прошивки для ПЛИС; 

 

3.3.1.1 Создание блок схемы “дизайна” аппаратной части и настройка 

параметров его блоков 

 

Назначение разрабатываемой системы приём тестовых данных по 

параллельной шине и отправка их по интерфейсу UART, входящему в состав 

периферии процессорного ядра Zynq. При разработке использовались платы LDM-

HELPER-XC7Z015-1CLG485 и LDM-HELPER-uMB301 электрическая схема 

соединения, которых приведена на рисунке 2: 
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Рисунок 2. Схема соединения плат LDM-HELPER-XC7Z015-1CLG485 и LDM-

HELPER-uMB301 

 

После сборки электрической схемы можно приступать к созданию блок схемы 

“дизайна” аппаратной части и настройке параметров его блоков. 

 

1) Запустим Vivado и создадим новый проект: 
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2) После создания проекта окно приобретёт вид, указанный на рисунке 3: 

 

Рисунок 3. Основное окно Vivado 

 

3) Для создания проекта блок схемы “дизайна” аппаратной части и настройки 

его параметров и блоков необходимо в панели “Flow Navigator” в 

подразделе “IP Integrator” выбрать пункт “Create Block Design”. В 

результате окно приобретёт вид, указанный на рисунке 4: 
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Рисунок 4. Окно Create Block Design 

 

Последовательно нажимая на кнопку “+”, позволяющую добавлять IP ядра 

добавить в проект ядра с следующими названиями: 

1) ZYNQ7 Processing System; 

2) Processor System Reset; 

3) AXI Interconnect; 

4) AXI GPIO. 

В итоге окно Create Block Design приобретёт следующий вид: 
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Затем необходимо произвести настройки ядер AXI Interconnect и AXI GPIO. В 

первом из них нужно отключить один из master интерфейсов, а во втором установить 

разрядность шины не 32, а 4 бита и включить все порты на вход. Выполнение этих 

действий поясняют рисунки 5 и 6. 

 

Рисунок 5. Настройка ядра AXI Interconnect 

 

Рисунок 6. Настройка ядра AXI Gpio 

 

После установки данных параметров необходимо соединить между собой IP 

разрабатываемого “дизайна” в соответствие с рисунком 7: 
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Рисунок 7. Схема разрабатываемого “дизайна” 

 

Порт btns_5bit, конфигурируется путем применения команды Make External из 

выпадающего меню, вызываемого правым щелчком мыши по порту IP AXI Gpio. 

В последнюю очередь конфигурируются параметры IP ZYNQ7 Processing 

System. В проекте необходимо настроить DDR память, а из периферийных 

интерфейсов необходимы QSPI, для подключения FLASH и непосредственно 

UART1. AXI интерфейс включен по умолчанию в режиме master. Процесс 

конфигурирования ядра поясняют рисунки 8-13. 

 

Рисунок 8. Настройка скорости интерфейса UART1 
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Рисунок 9. Настройка контроллера DDR (DDR Controller Configuration) 

 

Рисунок 10. Настройка контроллера DDR (Memory Part Configuration) 
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Рисунок 11. Настройка контроллера DDR (Training/Board Details)  

для платы версии ver.1.07 

 

 

Рисунок 12. Включение интерфейса UART1 
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Рисунок 13. Включение интерфейса QSPI Flash 

 

После настройки периферии необходимо определить адресное пространство, 

которое ей выделяется. Для этого необходимо в окне “Create Block Design” из 

вкладки “Diagram” перейти во вкладку “Address Editor” и применить команду “Auto 

Assign Address”. Выполнение этого действия изображает рисунок 14: 
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Рисунок 14. Автоматическое назначение адресов периферии 

 

На этом создание блок схемы “дизайна” аппаратной части и настройка 

параметров его блоков завершены. Можно приступать к процессу генерации HDL 

“обёртки”. 
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3.3.1.2 Генерация HDL “обёртки” для созданного “дизайна” 

 

Для генерации HDL “обёртки” для созданного “дизайна” необходимо перейти к 

вкладке “Sources” окна “Block Design”. В разделе “Design Sources” выделить 

строку с названием только что созданного “дизайна” и щелчком правой кнопки мыши 

вызвать контекстное меню, в котором выбрать пункт “Create HDL Wrapper”. После 

чего запустится процесс генерации HDL “обёртки” в автоматическом режиме. 

Процесс создания обёртки поясняется на рисунке 15: 

 

Рисунок 15. К процессу генерации HDL “обёртки” 

 

В результате будет создан файл описания на языке VHDL – рисунок 16: 
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Рисунок 16. Результат генерации HDL “обёртки” 

 

На этом генерация HDL “обёртки” завершена. Для перехода к процессам 

синтеза, имплементации и генерации файла прошивки ПЛИС, необходимо добавить 

файл физических ограничений для части системы, реализуемой на распределённой 

логике. 

 

3.3.1.3 Добавление файлов физических ограничений в формате XDC 

 

Создание файла физических ограничений, осуществляется путём нажатия 

кнопки “Add Sources”, находящейся в панели “Flow Navigator”, подменю “Project 

Manager”. Ограничения формировались с использованием принципиальной схемы 

платы LDM-HELPER-XC7Z015-1CLG485. Более подробно процесс создания файла 

физических ограничений поясняют рисунки 17-19: 
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Рисунок 17. К процессу генерации файла физических ограничений 

 

 

Рисунок 18. К процессу генерации файла физических ограничений 



DS-HELPER-XC7Z015-1CLG485-1.3 Dec., 2019 www.ldm-systems.ru +7(495)500-89-20 info@ldm-systems.ru 

Описание продукта 24

 

Рисунок 19. К процессу генерации файла физических ограничений 

 

Полный текст файла физических ограничений приведён ниже: 

set_property PACKAGE_PIN AA20   [get_ports {gpio_tri_i[0]}]; 
set_property PACKAGE_PIN R17    [get_ports {gpio_tri_i[1]}]; 
set_property PACKAGE_PIN T17    [get_ports {gpio_tri_i[2]}];   
set_property PACKAGE_PIN U19    [get_ports {gpio_tri_i[3]}]; 
 
set_property IOSTANDARD LVCMOS33 [get_ports {gpio_tri_i[0]}]; 
set_property IOSTANDARD LVCMOS33 [get_ports {gpio_tri_i[1]}]; 
set_property IOSTANDARD LVCMOS33 [get_ports {gpio_tri_i[2]}]; 
set_property IOSTANDARD LVCMOS33 [get_ports {gpio_tri_i[3]}]; 
 

После добавления файла физических ограничений можно переходить к 

процессам синтеза. имплементации и генерации файла прошивки. 

 

3.3.1.4 Синтез и имплементация созданного HDL описания “дизайна”, 

создание файла прошивки 

 

Синтез, имплементация, а также создание файла прошивки осуществляются 

средствами Vivado IDE в автоматическом режиме. Для запуска каждого этапа 

необходимо вызвать команды “Run Synthesis”,“Run Implementation” и “Generate 

Bitstream” находящихся в соответствующих разделах панели “Flow Navigator”. 

После выполнения всех перечисленных действий можно считать завершённой 

разработку аппаратной части системы и перейти к созданию программной части. 
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3.3.2 Написание программ для сконфигурированной аппаратной части 

платформы Zynq 

 

Проектирование программной части разрабатываемой системы ведётся в 

САПР SDK, входящей в комплект с IDE Vivado. Проектирование программной части 

также можно разбить на под этапы: 

1) Импортирование спецификации аппаратной платформы, созданной в 

Vivado на предыдущем этапе в SDK и конфигурирование пакета поддержки 

платы; 

2) Написание прикладного программного обеспечения; 

3) Формирование программы начального загрузчика FSBL и файлов прошивки 

для ПЛИС и флешки. 

 

3.3.2.1 Импортирование спецификации аппаратной платформы и 

конфигурирование пакета поддержки платы 

 

После завершения процесса генерации файла прошивки ПЛИС для написания 

прикладных программ, предназначенных для работы на базе разработанной 

аппаратной платформы, необходимо экспортировать описание аппаратной части в 

среду разработки SDK. Для этого в главном меню IDE Vivado необходимо открыть 

вкладку “File” и выбрать команду “Export->Export Hardware”. При этом появиться 

диалоговое окно, изображённое на рисунке 20: 

 

Рисунок 20. К процессу экспорта описания аппаратной платформы 

 

После выполнения процедуры экспорта спецификации аппаратной части 

необходимо запустить SDK выполнив в Vivado команду “File->Launch SDK”. После 

запуска пакета SDK его основное окно примет вид, указанный на рисунке 21: 
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Рисунок 21. Вид SDK после экспорта описания аппаратной платформы 

 

Так как спецификация аппаратной части уже загружена в SDK, необходимо 

создать пакет поддержки платы, по сути, являющийся набором драйверов, 

сопрягающих разработанную платформу с программным обеспечением. Для 

создания пакета поддержки платы необходимо выполнить следующую команду 

“File->New->Board Support Package”. В результате откроется диалог, 

представленный на рисунках 22-23: 

 

Рисунок 22. Первый диалог при создании пакета поддержки платы 
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Рисунок 23. Второй диалог при создании пакета поддержки платы 

 

В первом диалоге выбирается имя пакета поддержки платы, процессорное ядро 

для которого он создаётся и устанавливается используемая операционная система. 

По умолчанию в текущем проекте не предусмотрено использование ОС. В диалоге 

номер два (рисунок 23) в пакет добавляются специализированные библиотеки 

расширения. В данном случае необходима лишь библиотека “xilffs” для 

последующего создания проекта первичного загрузчика. После настройки данных 

параметров автоматически компилируется пакет поддержки платы и окно SDK 

приобретает следующий вид: 
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Рисунок 24. Вид SDK после генерации пакета поддержки платы 

 

На этом можно считать оконченным этап импортирования спецификации 

аппаратной платформы и конфигурирования пакета поддержки платы. 

 

3.3.2.2 Написание прикладного программного обеспечения 

 

После создания пакета поддержки платы по экспортированной спецификации 

аппаратной платформы можно приступить к созданию прикладного программного 

обеспечения. Для создания данного проекта необходимо выполнить команду “File-> 

New->Application Project”. После чего появиться окно, изображенное на рисунке 25: 
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Рисунок 25. Первый диалог при создании проекта прикладной программы 

 

В нём можно определить название проекта, процессорное ядро на котором он 

будет исполняться и используемый для этого пакет поддержки платы. После выбора 

соответствующих пунктов, появиться окно с шаблонами проектов для выбранного 

языка программирования, показанное на рисунке (в данном случае С): 
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Рисунок 26. Второй диалог при создании проекта прикладной программы 

 

По умолчанию в данном проекте будет использован шаблон “Hello World”. 

После нажатия кнопки “Finish” будет создан проект с шаблоном “Hello World” и 

окно SDK приобретёт вид, указанный на рисунке 27: 

 

Рисунок 27. Вид SDK после генерации проекта прикладной программы с 

шаблоном “Hello World” 
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Введём код тестовой программы, представленный ниже в файл “helloworld.c” 

и сохраним его. После чего произойдёт автоматическая компиляция проекта и в 

каталоге проекта появиться файл с расширением *.elf: 

/****************************************************************************** 
* 
* Copyright (C) 2009 - 2014 Xilinx, Inc.  All rights reserved. 
* 
* Permission is hereby granted, free of charge, to any person obtaining a copy 
* of this software and associated documentation files (the "Software"), to deal 
* in the Software without restriction, including without limitation the rights 
* to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
* copies of the Software, and to permit persons to whom the Software is 
* furnished to do so, subject to the following conditions: 
* 
* The above copyright notice and this permission notice shall be included in 
* all copies or substantial portions of the Software. 
* 
* Use of the Software is limited solely to applications: 
* (a) running on a Xilinx device, or 
* (b) that interact with a Xilinx device through a bus or interconnect. 
* 
* THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR 
* IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, 
* FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT 
SHALL 
* XILINX  BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
* WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF 
* OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE 
* SOFTWARE. 
* 
* Except as contained in this notice, the name of the Xilinx shall not be used 
* in advertising or otherwise to promote the sale, use or other dealings in 
* this Software without prior written authorization from Xilinx. 
* 
******************************************************************************/ 
 
/* 
 * helloworld.c: simple test application 
 * 
 * This application configures UART 16550 to baud rate 9600. 
 * PS7 UART (Zynq) is not initialized by this application, since 
 * bootrom/bsp configures it to baud rate 115200 
 * 
 * ------------------------------------------------ 
 * | UART TYPE   BAUD RATE                        | 
 * ------------------------------------------------ 
 *   uartns550   9600 
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 *   uartlite    Configurable only in HW design 
 *   ps7_uart    115200 (configured by bootrom/bsp) 
 */ 
//------------------------------------------------ 
//Подключаемые файлы: 
#include <stdio.h> 
#include <sleep.h> 
#include "platform.h" 
#include "xparameters.h" 
#include "xgpio.h" 
//------------------------------------------------ 
//  Определение идентификатора входного порта данных 
#define GPIO_INPUT_DEVICE_ID   XPAR_AXI_GPIO_0_DEVICE_ID 
//------------------------------------------------ 
//  Декларация функции чтения данных из входного порта 
int GpioInputData(u16 DeviceId, u32 *DataRead); 
XGpio GpioInput; /* The driver instance for GPIO Device configured as I/P */ 
//------------------------------------------------ 
int main() 
 { 
  init_platform(); 
  while(1) 
   { 
 int Status; 
 u32 InputData; 
    Status = GpioInputData(GPIO_INPUT_DEVICE_ID, &InputData); 
    if (Status != XST_SUCCESS) 
     { 
      return XST_FAILURE; 
     }; 
    print(&InputData); 
    sleep(1); 
   }; 
  cleanup_platform(); 
  return 0; 
 }; 
 
//------------------------------------------------ 
//  Определение функции чтения данных из входного порта 
int GpioInputData(u16 DeviceId, u32 *DataRead) 
 { 
  int Status; 
  Status = XGpio_Initialize(&GpioInput, DeviceId); 
  if (Status != XST_SUCCESS) 
   { 
    return XST_FAILURE; 
   }; 
  XGpio_SetDataDirection(&GpioInput, 1, 0xFFFFFFFF); 
  *DataRead = XGpio_DiscreteRead(&GpioInput, 1); 
  return XST_SUCCESS; 
 }; 
//------------------------------------------------ 
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При этом окно SDK примет вид, указанный на рисунке 28: 

 

 

Рисунок 28. Вид SDK после компиляции проекта прикладной программы 

 

Таким образом, мы создали проект прикладного программного обеспечения, 

осуществляющий чтение данных с входного параллельного порта данных и 

перенаправляющего принятые данные в приёмопередатчик UART. Далее 

необходимо создать проект загрузчика первого уровня. 
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3.3.2.3 Формирование программы начального загрузчика FSBL и файлов 

прошивки для ПЛИС и флешки 

 

Программа загрузчика начального уровня FSBL, представляет из себя, проект 

прикладного приложения, созданного с шаблоном “Zynq FSBL”, которой входит в 

состав шаблонов SDK предоставляемых по умолчанию (рисунок 29). 

 

Рисунок 29. Шаблон для проекта загрузчика начального уровня 

 

Дальнейшие действия полностью аналогичны процессу создания прикладного 

приложения за исключением того, что нет необходимости дописывать свой код в 

проект. В результате компиляции проекта в его папке также появиться файл с 

расширением *.elf. (рисунок 30) 
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Рисунок 30. Вид SDK после компиляции проекта загрузчика начального уровня 

 

Далее необходимо сформировать файлы прошивки для ПЛИС и флэшки. 

Заметим, что файлы прошивки для первой уже были созданы. Ими являются *.bit 

файл, сгенерированный в Vivado и *.elf файл, сгенерированный в проекте 

прикладного программного обеспечения. Поэтому на данном этапе уже можно 

попробовать запустить проект. Для этого необходимо сначала загрузить в ПЛИС *.bit 

файл, а затем запустить файл *.elf, проекта прикладного программного обеспечения. 

Для загрузки *.bit файла из среды SDK необходимо выполнить команду “Xilinx Tools 

- > Programm FPGA” (предварительно необходимо подключить плату к ПК через 

JTAG программатор (например XB-XUP USB-JTAG) и подать на неё питание). Для 

подключения JTAG программатора к плате можно использовать переходник с IDC10 

на PBS-12 (LDM-ADAP-JTAG Xilinx - в комплектацию не входит) рисунок 31. 

 

Рисунок 31. Вид переходника LDM-ADAP-JTAG Xilinx 
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В результате появиться окно, изображённое на рисунке 32: 

 

 

Рисунок 32. Программирование ПЛИС через JTAG в SDK 

 

После успешной загрузки конфигурационной последовательности, необходимо 

на уже прошитой плате запустить проект прикладного программного обеспечения. 

Для этого необходимо в панели “Project Explorer” выбрать папку с прикладной 

программой и в её под директории “Binaries” выбрать файл с расширением *.elf. В 

контекстном меню нужно выбрать следующую команду: “Run AS-> Launch on 

Hardware (GDB)” (рисунок 33). 
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Рисунок 33. Запуск проекта прикладной программы на уже сконфигурированной 

аппаратной части 

 

После выполнения данной операции прикладное приложение будет запущенно 

на аппаратной платформе. 

Таким образом, осталось сформировать лишь файл прошивки для флэшки и 

прошить её. Для создания файла прошивки флэш памяти необходимо выделить в 

панели “Project Explorer” папку прикладной программы и в контекстном меню 

выбрать команду “Create Boot Image” в результате выполнения которой появиться 

окно, изображённое на рисунке 34: 

 

Рисунок 34. Диалог создания образа для флэш памяти 
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Этот диалог показывает, какие файлы войдут в загрузочный образ для флэшки. 

По умолчанию в него обязательно входит файл *.elf загрузчика первого уровня, 

файл *.bit конфигурации аппаратной части, разрабатываемой платформы и файл 

*.elf проекта прикладного программного обеспечения. Также можно задать выходной 

формат файла и его месторасположение. Для данного проекта выходной файл 

должен иметь расширение *.mcs.  

После генерации данного файла в папке проекта прикладного программного 

обеспечения появиться под директория “bootimage”, в которой и будет находиться 

сгенерированный файл. Его загрузку можно осуществить средствами SDK выполнив 

команду “Xilinx Tools->Program Flash”. При этом появиться окно изображенное на 

рисунке 35: 

 

Рисунок 35. Программирование флэш памяти в SDK 

 

Таким образом, был показан цикл разработки проекта на аппаратной – 

программной платформе ZYNQ с применением средств Xilinx Vivado и Xilinx SDK. 

Данный цикл, применим к проектам любой сложности, реализуемого на платформе 

ZYNQ. 

 

3.4 Комплектация 

 отладочная плата LDM-HELPER-XC7Z015-1CLG485; 

 CD-диск с описанием к плате, демонстрационными примерами и 

дополнительным программным обеспечением. 
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3.5 Монтажные чертежи 

Слой TOP 

 

 

Слой BOTTOM 
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3.6 Трассировка по слоям 

Слой TOP 

 

 

Слой LAYER 1 
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Слой LAYER 2 

 

 

Слой LAYER 3 
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Слой LAYER 4 

 

 

Слой LAYER 5 
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Слой LAYER 6 

 

 

Слой BOTTOM 
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Присоединительные размеры 

  

6 

1,2
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4 Эксплуатация, хранение и транспортирование 

 

Требования к условиям эксплуатации:  

Изделие при испытаниях, перевозке, хранении и эксплуатации не наносит вреда 

окружающей среде и здоровью человека. Сохраняет свои параметры во всем 

диапазоне рабочих температур от 0°С до +70°С в закрытом помещении с 

относительной влажностью воздуха не более 80 %, без конденсата, при изменении 

напряжения первичного источника электропитания в допустимых пределах. По 

электромагнитной совместимости изделие соответствует всем требованиям для 

аппаратуры данного класса. 

 

Требования к условиям хранения: 

Изделие должно храниться в складских помещениях, защищенных от 

воздействий атмосферных осадков, на стеллажах в упаковке производителя при 

отсутствии в воздухе паров кислот, щелочей и других веществ, вызывающих 

коррозию. Условия хранения изделия по ГОСТ 15150-69: температура воздуха от 

+5°С до +40°С, относительная влажность до 80% при температуре +25°С. 

Предельный срок хранения в указанных условиях - три года.  

 

Требования к условиям транспортирования: 

Транспортирование изделия разрешается в упаковке производителя всеми 

видами транспорта, за исключением негерметизированных отсеков самолета, без 

ограничения расстояния. 

Транспортирование упакованных изделий может производиться в крытых 

вагонах и автомашинах, трюмах судов и герметичных кабинах самолетов при 

температуре воздуха от -20°С до +70°С. При любом способе транспортирования 

необходимо предусмотреть крепление ящика к кузову (платформе) транспортного 

средства с помощью крепежной арматуры. 


